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8.1.3  THEORIE- / ÜBUNGS-
          BLÄTTER ZU «BLENDER»

ÜBER DIESES LEHRMITTEL

3D-Modellieren und 3D-Drucken | S. Mauroux

s. 1 / 1

Dieses Lehrmittel besteht aus einzelnen Modulen, welche sich alle rund um das Thema «3D-Mo-
dellieren und 3D-Drucken» drehen. Das Material von diesen Modulen liegt entweder als Präsen-
tationsfolie oder als A4-Ausdruck vor. Die Module sind in drei Hauptkategorien aufgeteilt, welche 
zu Gunsten der Übersicht mit einem Piktogramm versehen sind. Die Module «Theorie» vermitteln 
Fachwissen zum 3D-Druck sowie theoretisches Hintergrundwissen zur 3D-Computergrafik. Die 
Module «Übung» ermöglichen das erworbene Fachwissen mithilfe von einer Schritt-für-Schritt 
Anleitung auszuprobieren und zu verfestigen. Die Module «Ausgabe» behandeln den Übergang 
vom virtuellen zum physischen Objekt und dessen Nachbearbeitung. Die schwarzen Balken 
oben rechts beinhalten jeweils den Modultitel, während die grauen Balken Untertitel, sowie Sei-
tenzahlen aufzeigen. Unten links wird der Themenkreis und der Namen der Autorin genannt.

Übung AusgabeTheorie

Nach Durcharbeiten dieses Lehrmittels sind Sie in der Lage mit Hilfe der erlernten Modellie-
rungsarten eigene virtuelle Objekte zu konstruieren, deren Geometrie zu prüfen und schliesslich 
massgetreu für den 3D-Druck zu exportieren. Zudem verfügen Sie über Informationen bezüglich 
Eigenschaften, Chancen und Grenzen der aktuellen 3D-Drucker und können dank diesen eigene 
Projekte beurteilen und realisieren.
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Abb. 1

Blender ist der Name einer 3D-Computergrafik 
Software, welche in den 90er Jahren von dem 
Holländer Ton Roosendaal gegründet wurde. 
Im Jahr 2002 wurde die Lizenz freigekauft, 
seither ist Blender als Open-Source Software 
kostenlos zugänglich. Blender läuft auf allen 
gängigen Betriebssystemen (Windows, Mac, 
Linux). Rund um Blender existieren verschie-
denste Internet-Communities, welche fortlau-
fend Werke oder / oder Tutorials (filmische Ge-
brauchsanweisungen) aufschalten. Beispiele 
für sehenswerte, aktive Communities sind 
http://wiki.blender.org, www.blenderpolis.de, 
www.blenderartists.org und www.blendernati-
on.com. 

Die Software Blender dient dem Erstellen von 
3D-Modellen, welche als Einzelbild oder als 
Animation gerendert oder mittels 3D-Drucker 
ausgedruckt werden können. Weiter verfügt 
die Software über eine Game Engine, welche 
ermöglicht interaktive Anwendungen in 3D zu 
realisieren.

Voreinstellungen: Blender kann gratis auf 
www.blender.org heruntergeladen werden, die 

Installation verläuft selbsterklärend. Es emp-
fiehlt sich das Programm auf Englisch zu las-
sen und nicht auf Deutsch umzustellen, in den 
meisten Tutorials sowie auch in diesem Lehr-
mittel werden stets die englischen Fachbegrif-
fe und Funktionen verwendet. 

Für die Arbeit mit Blender ist, neben der Tas-
tatur, eine Dreitastenmaus empfehlenswert. 
Unter File > User Preferences können jegliche 
Anpassungen betreffend Erscheinungsform, 
Eingabe und Ähnlichem vorgenommen wer-
den. Allerdings empfiehlt sich auch hier, wenn 
möglich nicht von den Standard-Einstellungen 
abzuweichen, da man sich sonst von der Blen-
der-Community entfernt. Für dieses Lehrmittel 
müssen einzig die folgenden Veränderungen 
vorgenommen werden: User Preferences > In-
put > Select with left. So wird mit der linken 
Maustaste ausgewählt, anstatt mit der rech-
ten. Mit links auszuwählen kennt man aus den 
meisten Programmen, während die Auswahl 
mit rechts eher ungewohnt wäre. Je nach Maus 
ist es nötig, Emulate 3 buttons mouse anzu-
wählen um alle nötigen Funktionen damit aus-
üben zu können. Wer je nach Tastatur keinen 
einzelnen Zahlenblock hat, muss weiter in den 
User Preferences > Input > Emulate Numpad 
aktivieren. So können die Zahlen oberhalb der 
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Buchstaben als Zahlenblock verwendet wer-
den. Veränderungen in den User Preferences 
werden erst angewendet, wenn im Anschluss 
Save User Settings geklickt wird. (Abb.2)

Workflow: Blender gewährleistet dem Nutzer 
schnelles Arbeiten dank Tastenkürzeln, auch 
Hotkeys oder Shortcuts genannt. Alle gängi-
gen Funktionen können in Blender über Tas-
tenkürzel ausgeführt werden. Dies spart Zeit 
und unterstützt den Arbeitsfluss. Für Anfänger 
sind diese Tastenkürzel vorerst überfordernd, 
aber schon nach kurzer Zeit möchte man nicht 
mehr ohne diese arbeiten. Deshalb verwendet 
dieses Lehrmittel von Anfang an Tastenkürzel.  
Weiter wird der Arbeitsfluss durch die Vertei-
lung der Funktionen unterstützt. Man findet 
an verschiedenen Stellen des Programms ein 
und die selben Funktionen, was vorerst un-
übersichtlich wirken mag, aber schliesslich 

Abb. 2

auch dem schnellen und individuellen Arbeiten 
dient. Zusätzlich können alle Funktionen über 
die Leertaste abgerufen werden, komplizierte 
Tastenkürzel müssen also nicht auswendig ge-
lernt werden. 

In diesem Lehrmittel werden Tastenkürzel wie 
folgt kommuniziert: soll eine einzelne Taste ge-
drückt werden, steht diese einzeln in eckigen 
Klammern, beispielsweise [R]. Sollen mehrere 
Tasten einzeln nacheinander gedrückt werden, 
so stehen diese ebenfalls in eckigen Klam-
mern, unterteilt mit einem vertikalen Strich, 
zum Beispiel: [R | Z]. Sollen Tasten gleichzeitig 
gedrückt werden, wird dies mit einem Unter-
strich gekennzeichnet, beispielsweise [ctrl_R]. 
Fachbegriffe aus Blender, wie Object Mode, 
werden kursiv geschrieben. 

Navigieren: Beim Öffnen von Blender findet 
man zuerst eine Standard-Einstellung. Sicht-
bar ist der unbegrenzte dreidimensionale Ko-
ordinatenraum (X-, Y-, Z-Achsen), im Zentrum 
ein Würfel, eine Lichtquelle und eine Kamera. 
Diese ersten Elemente bilden zusammen be-
reits eine Szene. Mit dem Mausrad lässt sich 
in die Szene ein- und auszoomen, mit gehal-
tenem Klick auf dem Mausrad kann man um 
die Objekte drehen, respektive den Blickwinkel 
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ändern, und mit [shift_mittlere Maustaste] kann 
die Szene nach rechts, links, oben oder unten 
verschoben werden. Jeweils unten links in der 
3D-View sind farbige Mini-Achsen, welche die 
Orientierung im dreidimensionalen Koordina-
tenraum vereinfachen. Wird der Blickwinkel 
geändert, drehen die Achsen mit. 

Ansichten: Mit [1] wird die Ansicht von vorne 
eingeschaltet, mit [3] die Ansicht von rechts, 
mit [7] die Ansicht von oben. [ctrl_1] zeigt die 
Ansicht von hinten, [ctrl_3] die Ansicht von 
links, [ctrl_7] die Ansicht von unten. Mit [5] 
wechselt man von der orthogonalen (parallel-
perspektivischen) zur fluchtpunktperspekti-
vischen Sicht und umgekehrt. [0] wechselt in 
die Kamerasicht und wieder zur aktuellen Sicht 
zurück. Mit [ctrl_alt_Q] lässt sich in die Quad 
View wechseln (und wieder zurück). In der 
Quad View sind gleichzeitig 4 Fenster sichtbar, 
diese zeigen die orthogonalen Risszeichnun-
gen (Aufriss, Seitenriss, Grundriss) und die ak-
tuelle Ansicht. All diese verschiedenen Ansich-
ten können auch unten links beim Menü View 
geholt werden.

Fenster: Ansichtsfenster können nach per-
sönlichen Bedürfnissen angepasst werden. An 
den Trennlinien können Fenster gepackt und in 
der Grösse verändert werden. Weiter kann in 
der rechten oberen Ecke ein Fenster unterteilt, 
in der Grösse verändert und wieder vereint 
werden. (Wieder vereinen: Wieder oben links 
in der gestrichelten Ecke packen und über das 
zu löschende Fenster ziehen). Ganz in der Mit-
te befindet sich die 3D-View, eine dreidimen-
sionale Raumdarstellung (Abb. 4). Oben am 
rechten Rand befindet sich der Outliner, die-
ser listet die Objekte der aktuellen Szene auf. 
Ebenfalls am rechten Rand, gleich unter dem 
Outliner, befindet sich der Properties Editor, 
wo die meisten Einstellungen getätigt werden 
können. [T] holt, respektive versteckt, das Tool 
Shelf auf der linken Seite. Darauf befinden sich 
Transformations-Werkzeuge. [N] holt, respek-
tive versteckt, das Properties Shelf, auf wel-

Abb. 3
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chem Objekte direkt mit numerischen Werten 
manipuliert werden können. Optional können 
diese beiden Fenster mit dem kleinen Pluszei-
chen aktiviert werden. Zum wieder Verstecken 
das offene Fenster am Rand packen und zur 
Seite schieben. Am unteren Rand ist die Time-
line sichtbar, welche bei Animationen von Be-
deutung wird.

Object Mode: Standardmässig befindet man 
sich vorerst im Object Mode. Hier werden Ob-
jekte zueinander gesetzt, belichtet und geren-
dert. Mit [shift_A] öffnet sich das Add-Menü, 
unter Mesh können der Szene Grundkörper 
hinzugefügt werden. Diese Meshes sind 3D-

Abb. 4

Gittermodelle, bestehend aus Flächen, Kan-
ten und Punkten. Die neuen Objekte erschei-
nen dort wo sich der 3D-Cursor, Fadenkreuz 
mit rot-weissem Kreis, aktuell befindet. Mit 
den oben genannten Einstellungen in den 
User Preferences kann dieser 3D-Cursor mit 
Rechtsklick verschoben werden. Wurde er aus 
Versehen verschoben, kann er mit [shift_S] 
wieder ins Zentrum zurück gebracht werden 
(Cursor to Center).

Auswahl: Ist ein Objekt mit der linken Maus-
taste ausgewählt, erscheint es orange um-
randet. Mit [A] können ausgewählte Objekte 
wieder abgewählt werden. Ist nichts ausge-
wählt, kann mit [A] alles ausgewählt werden. 
Mehrfach-Auswahlen gelingen mit zusätzlich 
gehaltener Shift-Taste. Mit [B] (Border Select) 
kann mithilfe von einem Rechteck die Auswahl 
getroffen werden. Analog funktioniert die Cir-
cle Select [C], der Auswahlbereich kann mit 
dem Mausrad verändert werden. Unten links 
im Menü Select stehen die oben genannten 
sowie weitere Auswahloptionen, wie zum Bei-
spiel Random für zufällige Auswahlen, zur Ver-
fügung.

Manipulationen: Ausgewählte Objekte kön-
nen direkt mit der Maus verschoben werden. 
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Es empfiehlt sich, an den farbigen Pfeilen zu 
ziehen um das Objekt auf der entsprechenden 
Achse zu bewegen.  Direkt oberhalb der Time-
line kann zwischen 3 verschiedenen Manipu-
lationspfeilen ausgewählt werden (einer zum 
Verschieben, einer zum Rotieren, einer zum 
Skalieren, Abb. 5).

Ständig diese Pfeile zu wechseln wäre um-
ständlich, daher empfiehlt es sich für diese 
Grund-Manipulationen Tastenkürzel zu ver-
wenden. Mit [G] und der Mausbewegung kann 
das Objekt verschoben werden. Mit [S] und der 
Bewegung der Maus kann das Objekt skaliert 
werden. Mit [R] und der Mausbewegung wird 
das Objekt rotiert. Jede Veränderung ist von 
der Position der Maus abhängig. Befindet sich 
der Mauszeiger in der Nähe des Objekts, fallen 
die Bewegungen heftig und unkontrolliert aus. 
Wenn sich der Mauszeiger weiter weg vom Ob-
jekt befindet, werden langsame und gut kont-
rollierbare Veränderungsschritte möglich. Wird 
[S] und anschliessend eine Zahl eingegeben, 
skaliert Blender das Objekt nach diesem Fak-
tor. Beispielsweise [S | 0.5] halbiert das Objekt. 
Dasselbe beim Verschieben, [G] und eine Zahl 

verschiebt das Objekt um die entsprechende 
Zahl (in Blender-Einheiten). [R] und eine Zahl 
rotiert den Körper um die entsprechende An-
zahl Grad. Soll eine Veränderung nur auf einer 
bestimmten Achse stattfinden, kann zwischen 
dem Befehl und der Zahl noch die erwünsch-
te Achse genannt werden. Beispielweise [S | 
Y | 2] verdoppelt das Objekt einzig auf der Y-
Achse. Wird [S | shift_Z] gedrückt, findet die 
Manipulation einzig auf den X- und Y-Achsen 
statt, die Z-Achse ist so blockiert. Auf dieselbe 
Weise kann rotiert oder verschoben werden. 
Wenn schrittweise verschoben, rotiert oder 
skaliert werden soll, wird die Steuerungs-Taste 
gleichzeitig gedrückt, so verändern sich die 
Schritte in Fünfteln. Für Zehntel-Schritte wird 
zusätzlich die Shift-Taste gedrückt. Alle Be-
fehle können entweder mit Linksklick oder mit 
[Enter] abgeschlossen werden.

Aufräumen: Verschiebt sich ein Objekt ins 
nirgendwo, kann die Operation über [ctrl_Z] 
widerrufen oder das angewählte Objekt über 
[alt_G] zum Zentrum gebracht werden. Links 
im Tool Shelf findet man unter History auch die 
Möglichkeit, Schritte rückgängig zu machen. 
Mit [shift_S] öffnet sich das Snap-Menü, hier 
kann die Auswahl zum 3D-Cursor bewegt wer-
den. (Abb. 6)

Abb. 5
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Muss ein Objekt gelöscht werden, wird es an-
gewählt und mit [X] entfernt. Es gilt zu beach-
ten, dass jegliche Tastenkürzel-Befehle nur er-
teilt werden können, wenn sich die Maus über 
dem entsprechenden Fenster befindet. Ein 
neues File kann mit [ctrl_N] geladen werden.

Edit Mode:  Ist ein Objekt angewählt, kann 
man mit der Tabulator-Taste vom Object Mode 
in den Edit Mode wechseln. Zurück gewech-
selt wird ebenfalls mit [Tabulator]. Im Object 
Mode wird die gesamte Szene gestaltet, die 
Objekte werden verschoben, belichtet und ge-
rendert. Hingegen im Edit Mode wird nur das 
angewählte Objekt verändert, respektive an 
der Geometrie des Objekts gearbeitet. Knapp 
oberhalb der Timeline ist es möglich zwischen 
Vertex (Punkt), Edge (Kante) und Face (Fläche) 
-Select auszuwählen. (Abb. 7)

Abb. 6

Beim Face-Select kann an einzelnen Flächen 
eines Objekts herumgezogen werden. Analog 
kann an einzelnen Vertices oder Edges gezo-
gen werden. Mit gehaltener Shift-Taste kön-
nen mehrer Modi gleichzeitig aktiviert werden.  
Auch hier kann die Veränderung auf einzelne 
Achsen beschränkt werden ([X], [Y], [Z]). Mit 
der Funktion Subdivide links im Tool Shelf 
kann die Anzahl Gitterpunkte verdoppelt oder 
vervielfacht werden. So ergeben sich mehr 
Möglichkeiten zur Veränderung. Eine der be-
liebtesten Funktionen im Edit Mode ist das 
Extrudieren [E]. Eine ausgewählte Fläche (oder 
auch Kante, Punkt) kann mit [E] in die Tiefe ge-
zogen werden. (Abb. 8)

Abb. 7

Abb. 8
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Abb. 1

Abb. 2

[Mausrad scrollen]
[Mausrad drücken & halten]

[shift_Mausrad drücken]

[A]

[X]

[shift_A]

Navigieren
in Szene ein- / auszoomen
Blickwinkel ändern
Szene nach oben / unten / rechts / links 
schieben

Objekte hinzufügen Im Add- Menü (unten 
links, Abb. 2) können unter Mesh verschie-
dene Grundformen gewählt und in die Szene 
eingefügt werden.

alles aus- / abwählen (optional unter Select > 
(De)Select All)
Auswahl löschen (optional unter Object > 
Delete)
öffnet das Add-Menü ebenfalls

Zuerst sollte unter File > User Preferences > Input > Select with Left eingestellt werden.  Verfügt 
die Tastatur über keinen einzelnen Zahlenblock, so muss am selben Ort Emulate Numpad akti-
viert werden. Vor dem Schliessen dieses Fensters auf Save User Settings klicken. (Abb. 1)
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Abb. 4

Abb. 5

[G]
[R]
[S]

[5]

[1]
[3]
[7]

[Leertaste]

Objekte verändern: Oberhalb der Timeline 
(Abb. 3) können verschiedene Arten von Pfei-
len ausgewählt werden: Der gewöhnliche Pfeil 
ermöglicht das Objekt zu verschieben. Mit 
dem geschwungenen Pfeil kann das Objekt 
rotiert werden. Der Pfeil mit dem Würfel er-
möglicht das Objekt in der Grösse zu verän-
dern. (Abb. 4)

Verschieben der Auswahl (grab / Greifen)
Rotieren der Auswahl (rotate / Rotieren)
Skalieren der Auswahl (scale / Skalieren)

Ansicht: Über das View-Menü oder mit den 
folgenden Tastenkürzeln:

Wechsel zwischen orthogonaler und flucht-
punktperspektivischer Ansicht
Szene von vorne
Szene von rechts
Szene von oben

öffnet den Sucher: Alle Funktionen können 
über die Leertaste gesucht und direkt ausge-
führt werden. (Abb. 5)

Abb. 3
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Diese Tastenkürzel bedingen folgende Änderungen in den User Preferences: User Preferences > 
Input > Select with Left. Je nach Tastatur: Emulate Numpad (Zahlenblock nachbilden) aktivieren.

Navigieren
ein- auszoomen in Szene
Blickwinkel in 3D-View ändern
Szene nach oben / unten / rechts / links ver-
schieben

Ansicht
Wechsel zwischen fluchtpunktperspektivi-
scher und orthogonaler Ansicht
Front-Ansicht (Szene von vorne)
Right-Ansicht (Szene von rechts)
Top-Ansicht (Szene von oben)
Szene von hinten, links, unten
Wechsel zwischen Kamerasicht und aktueller 
Ansicht
Quad View (4 Ansichten gleichzeitig: Aufriss, 
Seitenriss, Grundriss und aktuelle perspektivi-
sche Ansicht
aktuelle Ansicht in Gradschritten drehen (auf 
der Waagrechten)
aktuelle Ansicht in Gradschritten drehen (auf 
der Senkrechten)

[Mausrad scrollen]
[Mausrad drücken & halten]

[shift_Mausrad drücken]

[5]

[1]
[3]
[7]

[ctrl_1] (analog 3, 7)
[0]

[ctrl_alt_Q]

[4], [6]

[2], [8]
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[G]
[R]
[S]

[Linksklick], [Enter]
[ctrl_G] (R,S)

[G | X], analog mit S, R und Y, Z

 [G | X | 2] (analog mit S, R und Y, Z und Zahl)

[G  | shift_X] (analog mit R, S und Y, Z)

[Tabulator]
[Rechtsklick]

[shift_A]
[shift_D]

[alt_D]
[X]
[N]
[T]

[ctrl_Z]
[shift_ctrl_Z]

[E]
[Z]

[ctrl_S]
[ctrl_N]

Wichtiges
Verschieben der Auswahl (Grab)
Rotieren der Auswahl (Rotate)
Skalieren der Auswahl (Scale)
schliesst die laufende Aktion ab
die selben Aktionen in fixen Schritten
Aktionen werden auf Achse beschränkt, [G | X] 
Objekt nur auf X-Achse verschoben
führt die Aktion mit einem genauen Zahlenwert 
aus. [G | X | 2] verdoppelt entlang der X-Achse
blockiert die gedrückte Achse, die Aktion fin-
det auf den anderen beiden Achsen statt
wechselt zwischen Object- und Edit Mode
verschiebt den 3D-Cursor
öffnet das Add-Menü im Object Mode
Auswahl duplizieren
Auswahl verlinkt duplizieren
Löschen der Auswahl
holt / versteckt das Properties Shelf
holt / versteckt das Tool Shelf
einen Schritt zurück (Undo)
den rückgängig gemachten Schritt wiederher-
stellen (Redo)
extrudieren, in den Raum ziehen (Edit Mode)
Wechsel zwischen solider und Drahtgitter-An-
sicht
Datei als Blender-File speichern
neues File öffnen
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[A]
[B]
[C]

[shift_Linksklick]
[ctrl_Rechtsklick]

[W]
[alt_C ]

[G | Y | Y], analog mit R und S, sowie mit allen 
Achsen]
[ctrl_R]

[ctrl_tab]

[ctrl_J]
[P]

[shift_S]
[ctrl_B]

[F]

[ctrl_T]
[ctrl_A]

[ctrl_M_X] (analog Y, Z)
alt_Linksklick

Auswahl
alles aus- / abwählen
Border-Select, Auswahl mit einem Rechteck
Circle-Select, Auswahl mit einem Kreis (Maus-
rad verändert den Radius)
Mehrfach-Auswahl
Lasso-Auswahl (Edit Mode)

Details
Specials-Menü (Edit Mode)
Konvertieren von Objekten (Object Mode)
ermöglicht ein bereits rotiertes Objekt entlang 
seiner ursprünglichen Achse zu manipulieren
Loop Cut and Slide (Edit Mode)
Mesh Select Mode (im Edit Mode, zum Bear-
beiten der Vertices, Edges, Faces)
Auswahl vereinen (Join)
Separate-Menü
Snap-Menü
Bevel, Kanten brechen (Edit Mode)
verbindet (mind. zwei) angewählte Vertices, 
Edges oder Faces
Trianguliert die Auswahl
Apply-Menü (Skalierung / Rotation anwenden)
Spiegeln entlang bestimmter Achse 
wählt einen Kantenring aus (Edge Loops, Edit 
Mode)



MODUL: MODELLIEREN MIT GRUNDFORMEN

3D-Modellieren und 3D-Drucken mit Blender | S. Mauroux

s. 1 / 1

Abb. 1

Eine Möglichkeit in Blender zu Modellieren 
besteht darin, Objekte aus den im Programm 
existierenden Grundformen (Plane, Cube, Cir-
cle, UV Sphere, Ico Sphere, Cylinder, Cone, 
Torus, Grid, Monkey) aufzubauen. Diese 
Grundformen sind unter dem Menü Add als 
Mesh-Objekte gruppiert. (Abb. 1) Mesh steht 
für Gitternetz-Objekte und beschreibt die Be-
schaffenheit dieser virtuellen Körper. (Abb. 2)
 

Für den 3D-Druck müssen die einzelnen For-
men korrekt mit dem Boolean-Modifikator zu 

einem einzigen Objekt verbunden werden. 
Dieser Modifikator ist am rechten Rand bei 
den Properties zu finden (Icon: Schrauben-
schlüssel, Abb. 3). 

Das Verbinden erfolgt mit der Operation  Uni-
on. Mit dem Boolean-Modifier können ausser-
dem Grundformen voneinender abgezogen 
(Difference) oder Schnittmengen gebildet wer-
den (Intersect). Der Modifikator muss jeweils 
mit Apply angewendet werden. (Abb. 4)

Diese drei booleschen Operationen existieren 
in den meisten 3D-Computergrafik-Program-
men.

Abb. 2

Abb. 3

Abb. 4
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Abb. 1

• Den Standardwürfel (Cube) mit [X] löschen.
• Mit [shift_A] einen Torus hinzufügen und nicht 
verschieben. 
• Links in Tool Shelf den Torus ändern: Major 
Segments 60, Minor Segments 22, Major Ra-
dius 3.5, Minor Radius .1 (Abb. 1)

• Das metrische System (der Szene) wird nicht 
eingeschaltet, sondern davon ausgegangen, 
dass eine Blendereinheit einem Zentimeter 
entspricht. [N] öffnet das Fenster für numeri-
sche Werte und zeigt bei diesen Angaben: X 
9.000, also 9 cm. Hier können auch direkt Zah-
lenwerte eingegeben werden.
• Mit [shift_A] einen Cylinder hinzufügen und 
links unten im Tool Shelf folgendes einstellen: 
Vertices 8, Radius 0.475, Depth 17.000. (Die-
se Masse entsprechen Bleistiften, Farbstiften 

oder Stabilo-Stiften. Für dickere Stifte em-
pfiehlt sich ein Radius von 0.6 und 12 Vertices.)
• Mit [5] und [3] in die orthogonale Seitenan-
sicht wechseln und den Cylinder mit [R I 10] 
rotieren.
• Den Cylinder entlang der Z- und Y- Achse 
verschieben, so dass er sich mit dem Torus 
überschneidet.  Dazu am besten mit [Z] die 
Gitternetz-Ansicht aktivieren. Optional mit die-
sen genauen Werten verschieben: [G I Z I 7.8] 
und [G I Y I 4.8]. (Abb. 2)

• Mit [5] und [7] in die orthogonale Top-Ansicht 
wechseln.
• Den Cylinder mit [shift_D] und [Enter] dupli-
zieren.
• Beim Duplikat im Properties Shelf unter Lo-
cation das Vorzeichen vom Y- Wert wechseln, 
sowie das Vorzeichen von der X- Rotation.
• Beide Cylinder anwählen und mit [shift_D] 
duplizieren, diese Aktion mit [Enter] abschlies-
sen und beide Cylinder mit [R I 36] rotieren. 
Diesen Schritt 7-mal wiederholen.

Abb. 2
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• Mit [3] in die Seitenansicht wechseln, mit [B] 
(Border-Select) alle Cylinder auswählen und 
mit [ctrl_J] verbinden.
• Dem Torus einen Boolean Modifier hinzufü-
gen, die Operation auf Difference stellen und 
als Hilfsobjekt die vereinten Cylinder auswäh-
len. Den Vorgang mit Apply anwenden.
• Das Hilfsobjekt (die vereinten Cylinder) mit [X] 
löschen. (Abb. 3)

 STIFT-HALTER | s. 2 / 2

Abb. 3

Abb. 4
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Abb. 1

• Den Standardwürfel (Cube) mit [S I X I 1.5], [S 
I Y I 5] und [S I Z I 0.15] skalieren.
• Diesen flachen Quader mit [shift_D] duplizie-
ren und die Aktion mit [Enter] abschliessen.
• Mit [5] und [1] in die orthogonale Ansicht von 
vorne wechseln.
• Einen von diesen Quadern mit [R I Y I 2] ro-
tieren und dann mit [G I Z I 0.25] verschieben. 
Dieser rotierte Quader dient als Hilfsquader. 
(Abb.1)

• Den nicht rotierten Quader anwählen und 
beim Schraubenschlüsselsymbol den Modifier 
namens Boolean holen. Die Operation auf Dif-
ference stellen und als Object den Hilfsquader 
wählen. Die Operation mit Apply ausführen. 
(Lässt sich die Operation nicht / nur fehlerhaft 

ausführen, dann muss der Hilfsquader noch 
mit [S I  X] und [S I Y] vergrössert werden, da-
mit die Überschneidung deutlich wird. Abb. 2)
• Den Hilfs-Quader mit [X] löschen. (Abb. 3)

• Mit [7] in die orthogonale Ansicht von oben 
wechseln. 
• Mit [shift_A] einen Cube holen.
• Diesen Cube mit [S I Y I 0.08] und [S I Z I 0.2] 
skalieren. (Abb. 4)
• Den Cube mit [G I X I 0.6] verschieben. 
• Den Cube jeweils mit [shift_D] duplizieren, 
diese Aktion mit [Enter] abschliessen und mit 
[G I Y I 0.3] verschieben. Diesen Schritt 14 mal 
wiederholen. (insgesamt 15 Cubes)
• All diese Cubes mit gehaltener Shift-Taste 
auswählen (oder mit [B]) und mit [ctrl_J] ver-
binden.
• Die 15 Cubes anwählen und mit [shift_D] du-
plizieren, diese Aktion mit [Enter] abschliessen.

Abb. 2

Abb. 3

Abb. 4
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• Die neuen Cubes mit [G I Y I -4.2] verschie-
ben. (Abb. 5)

• All diese Cubes nochmals anwählen und mit 
[ctrl_J] verbinden. 
• Optional zum Duplizieren kann mit dem Ar-
ray-Modifier gearbeitet werden.
• Den grossen Quader anwählen und rechts 
beim Schraubenschlüsselsymbol den Modi-
fikator namens Boolean holen. Die Operation 
auf Difference stellen und als Hilsobjekt die 
vereinten Cubes einstellen. (Abb. 6)

Abb. 6

Abb. 5

 • Den Boolean Modifier mit Apply anwenden 
und die Hilfsobjekte mit [X] löschen. (Abb. 7)

Abb. 8

Abb. 7
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Abb. 1

• Den Standardwürfel mit Linksklick anwählen 
und mit [S | 6] vergrössern.
• Unter Add (oder mit [shift_A]) eine Sphere 
hinzufügen und links im Tool Shelf unter Size 4 
einstellen. (Abb. 1)
• Diese Sphere mit [G | Z | 6] entlang der Z-
Achse um 6 Blender-Einheiten verschieben.
• Rechts bei den Properties auf das Schrau-
benschlüsselsymbol klicken und den Modifika-
tor namens Boolean auswählen. Die Operation 
auf Difference stellen und als Object den Cube 
definieren. Die Operation mit Apply ausführen 
lassen. (Abb. 2)

• Den Cube anwählen und mit [X] löschen. (war 
nur ein Hilfsobjekt)
• Mit [N] das Properties Shelf aktivieren. (oder 
auf dem kleinen Pluszeichen rechts oben bei 
der 3D-View)

• Mit [shift_A] einen neuen Cube hinzufügen 
und im Properties Shelf unter Dimensions die 
Masse des eigenen Smartphones eingeben. 
Jeweils einen Millimeter hinzugeben. Die Zah-
len können als Zentimeter angenommen wer-
den. (Die Zahlen in der Abb. 3 sind für das 
iPhone 5S)
• Dieses virtuelle Smartphone mit [R | Y | 10] 
rotieren. (10 Grad entlang der Y-Achse)
• Mit Hilfe der Achsenpfeile das Smartphone in 
die Halbkugel verschieben. (Optional mit ge-
nauen Zahlenwerten [G | Z | 13] und [G | X | 1])
• Nach Belieben die Halbkugel entlang der X- 
oder Y-Achse skalieren. [S | X] / [S | Y]
• Die Halbkugel mit Linksklick anwählen und 
beim Schraubenschlüsselsymbol den Boolean Abb. 2

Abb. 3
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Modifier hinzufügen. Die Operation auf Diffe-
rence stellen und als Hilfsobjekt das virtuelle 
Smartphone definieren. Mit Apply anwenden.
• Das Hilfsobjekt mit [X] löschen. (Abb. 4)

Abb. 4

Abb. 5
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Abb. 1

• Den Standardwürfel (Cube) mit [X] löschen.
• Mit [shift_A] einen Torus hinzufügen und nicht 
verschieben. 
• Unten links im Tool Shelf die Major und Minor 
Segments nach Wahl einstellen (ergibt Form).
• Mit [5] und [7] in die orthogonale Ansicht von 
oben und mit [Tabulator] in den Edit Mode 
wechseln.
• Mit [Z] die Wireframe-Ansicht einstellen.
• Mit der Border Select [B] eine Hälfte auswäh-
len und mit [G | X] zu einer länglichen Form 
bringen. (z.Bsp. mit [G | X | 0.5], Abb. 1)
• Mit [Tabulator] zurück in den Object Mode 
wechseln.

• Mit [shift_A] ein Empty Arrow hinzufügen und 
mit [R | X | 90] rotieren.
• Den Torus anwählen und beim Schrauben-
schlüsselsymbol den Modifier namens Array 
hinzufügen.

• Beim Array Modifier Object Offset aktivieren 
und als Objekt das rotierte Empty einstellen. 
(Abb. 2)
• Gleich oberhalb noch den X-Wert verstellen, 
so dass es eine günstige Überschneidung gibt.
• Die Zahl Count beliebig hoch stellen. (Länge 
der Kette)
• Mit Apply den Modifier anwenden.

Abb. 2

Abb. 3
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Abb. 1

• Den Standardwürfel (Cube) mit [X] löschen.
• Mit [shift_A] einen Torus hinzufügen und nicht 
verschieben. 
• Unten links im Tool Shelf die Major und Minor 
Segments nach Wahl einstellen (ergibt Form).
• Mit [5] und [7] in die orthogonale Ansicht von 
oben und mit [Tabulator] in den Edit Mode 
wechseln.
• Mit [Z] die Wireframe-Ansicht einstellen.
• Mit der Border Select [B] eine Hälfte auswäh-
len und mit [G | X] zu einer länglichen Form 
bringen. (z.Bsp. mit [G | X | 0.5], Abb. 1)
• Mit [Tabulator] zurück in den Object Mode 
wechseln.

• Mit [shift_A] ein Empty Arrow hinzufügen und 
mit [R | X | 90] rotieren.
• Den Torus anwählen und beim Schrauben-
schlüsselsymbol den Modifier namens Array 
hinzufügen.

• Beim Array Modifier Object Offset aktivieren 
und als Objekt das rotierte Empty einstellen. 
(Abb. 2)
• Gleich oberhalb noch den X-Wert verstellen, 
so dass es eine günstige Überschneidung gibt.
• Die Zahl Count beliebig hoch stellen. (Länge 
der Kette)
• Mit Apply den Modifier anwenden.

Abb. 2

Abb. 3
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Abb. 1

Falls der Boolean Modifier nicht, oder nur 
fehlerhaft, funktioniert, können die folgenden 
Tipps helfen:

• Beide Objekte um ein paar Milimeter ver-
schieben und erneut probieren.
• Die Reihenfolge der Auswahl ändern. (bei-
spielsweise zuerst Hilfsobjekt auswählen und 
erst dann das Hauptobjekt eingeben)
• Überschneidungen deutlich machen. (keine 
deckungsgleichen Flächen, Abb. 1)

• Mit [ctrl_A] die Skalierung und Rotation an-
wenden. (Object Mode)
• Im Edit Mode mit [A] alles auswählen und die 
Funktion Remove Doubles anwenden (Tool 
Shelf, Abb.2)

• Im Edit Mode mit [A] alles anwählen und mit 
[ctrl_N] die Flächennormalen auf der Aussen-
seite neuberechnen lassen. (diese Funktion ist 
auch unten links im Menü Mesh > Normals > 
Recalculate Outside zu finden, Abb. 3)

• Falls das Gitternetz ungünstig unterteilt ist, 
kann es (oder einzelne Flächen) mit [ctrl_T] tri-
anguliert werden.
• zur Not: beide Objekte auf www.tinkercad.
com hochladen. Die booleschen Operationen 
Union und Difference können dort ausgeführt 
werden. Schnittmengen zu bilden ist in Tinker-
cad allerdings nur über Umwege möglich.

Abb. 2

Abb. 3
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Abb. 1

Eine Modellier-Variante ist das Boxmodeling. 
Ausgehend von dem Standardwürfel, der Box, 
oder anderen einfachen Grundformen (wie 
Sphere, Cylinder, etc.) kann fast alles model-
liert werden. Flächen werden wenn nötig un-
terteilt, mittels Loop Cut and Slide oder über 
Subdivide. Beide Funktionen sind im Edit 
Mode auf der linken Seite im Tools Shelf [T] zu 
finden. Es gilt zu beachten, dass nur so viele 
Unterteilungen wie nötig gemacht werden soll-
ten, denn je mehr Flächen, Kanten und Punk-
te ein Objekt hat, desto rechenintensiver wird 
es. Je nach Slicer-Software können nicht mehr 
als eine halbe Million Punkte pro Objekt verar-
beitet werden.  Die Anzahl Punkte wird im Edit 
Mode am oberen Rand in der Mitte angege-
ben. (Abb. 1)

Die einzelnen Flächen ermöglichen genaues 
Bearbeiten der Vertices, Edges oder Faces im 
Edit Mode. Dabei sind die drei verschiedenen 
Modi gleich überhalb der Timeline zentral: der 
Vertex-, Edge-, und Face-Select. (Abb. 2) Alle 
bisherigen Manipulationsmöglichkeiten (grab, 
rotate, scale) können nun mit einzelnen Teilen 
ausgeführt werden. Wird ein Punkt (oder Kan-

ten, Fläche) gepackt, so reagieren die umlie-
genden Flächen mit. (Abb. 3) Hingegen beim 
Extrudieren [E] wird nur die entsprechende 
Fläche (oder Kante, Punkt) in den Raum gezo-
gen. (Abb. 4)

Abb. 2

Abb. 3

Abb. 4
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Abb. 1

• Den Standardwürfel mit [S] so skalieren, dass 
die Proportionen einem Tischblatt gleichen. [S] 
[Z] um den Würfel flach zu machen, [S] [Y] und 
[S] [X] um die Länge und Breite zu verändern.
• Den Quader anwählen (Linksklick) und mit 
[Tabulator] in den Edit Mode wechseln. 
• Mit  [5] und  [7] in die orthogonale Ansicht von 
oben wechseln.
• Links im Tool Shelf [T] den Loop Cut and Sli-
de anklicken. (Tastenkürzel [ctrl_R])
• Sobald man mit dem Mauszeiger an den 
Rand des Objekts kommt, erscheint eine vio-
lette Linie. Mit Linksklick wird diese aktiv und 
lässt sich dann verschieben. 
• Das Tischblatt am Rand unterteilen (Abb. 
1, am Hintergrund-Gitter orientieren, oder im 
Properties Shelf mit genauen Werten und ge-
gensätzlichen Vorzeichen arbeiten.)

• Die vier entstandenen Flächen mit Face-Se-
lect anwählen. (Mehrfachauswahlen mit gehal-
tener Shift-Taste) 
• Mit [E] auf die gewünschte Tischbeinlänge 

extrudieren (die Beine in den Raum ziehen, 
Abb. 2).

• Nach dem selben Prinzip können auch Stühle 
modelliert werden. Die Stuhlbeine können wie 
die Tischbeine nach unten extrudiert werden, 
die Rückenlehne entlang der Z-Achse nach 
oben. (Abb. 3)
• Im Object Mode kann der Stuhl mit [shift_D] 
dupliziert werden und in der orthogonalen Top-
Ansicht [5 | 7] platziert werden. 

Abb. 2

Abb. 3
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Abb. 1

• Den Standardwürfel mit [X] löschen und mit 
[shift_A] einen Cylinder hinzufügen.
• Links im Tool Shelf den Radius von diesem 
Cylinder auf 4 stellen.
• Mit [Tabulator] in den Edit Mode wechseln 
und mit [3 | 5] in die orthogonale Ansicht von 
rechts gehen.
• Mit [alt_Linksklick] den untersten Kantenring 
anwählen und mit [S | 0.9] verkleinern. (Abb. 1)

• Mit [alt_Linksklick] den oberen Kantenring 
anwählen und mit [E | 8] um acht Blenderein-
heiten vergrössern.
• Jeweils die folgenden Schritte mit der aktuel-
len Auswahl (= oberster Kantenring) vollziehen:
• Die Auswahl mit [S | 0.9] verkleinern.
• Den Kantenring mit [E | 2] extrudieren und mit 
[S | 1.1] vergrössern.
• Weiter mit [E | 6] und mit [E | 3] einen weiteren 
Abschnitt machen. Diesen neuen Abschnitt 
mit [S | 0.8] verkleinern.
• Erneut mit [E | 2] extrudieren und mit [S_0.4] 
den Ring verkleinern. (Abb. 2)

• Für den obersten Teil: Mit [E | 1] extrudieren 
und mit [E | Enter] eine deckungsgleiche Flä-
che schaffen.
• Diese Auswahl mit [S | 1.3] vergrössern und 
mit [E | 0.3] hochziehen.
• Erneut mit [E | Enter] eine deckungsgleiche 
Fläche schaffen und diese mit [S | 0.8] verklei-
nern und mit [E | 1.2] extrudieren. (Abb. 3)

Abb. 2

Abb. 3
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Abb. 4

Abb. 5

• Für Rillen: im Edit Mode den Loop Cut and 
Slide aktivieren und die Number of Cuts defi-
nieren. (z. Bsp. 10)
• Jeweils einen Kantenring mit [alt_Linksklick] 
anwählen und mit [S | 0.9] verkleinern. (Abb. 4)

• Eine Option zur Ausgangslage mit dem Mesh 
Cylinder bietet der Nurbs Cylinder bei den Sur-
faces. (Add-Menü)
• Für den 3D-Druck müsste der fertig mo-
dellierte Nurbs Cylinder mit [alt_C] zu einem 
Mesh-Objekt konvertiert werden. (Abb. 6)

Abb. 6
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Abb. 1

• Den Standardwürfel mit [S | Y | 0.5] entlang 
der Y-Achse halbieren.
• Mit [Tabulator] in den Edit Mode wechseln.
• Links im Tool Shelf auf Subdivide klicken und 
die Number of Cuts auf 2 stellen. (Abb. 1)

• Die zwei Seitenflächen oben mit [E | 0.2] und 
[E | 0.5] extrudieren. (Oberarme, Abb. 2)
• Am selben Teil die unteren Flächen wählen 
und mit [E | 0.7], [E | 0.3], [E | 0.7] extrudieren. 
(Abb. 3)

• Diese zwei Schritte auf der anderen Seite 
wiederholen.
• Für die Beine: 4 Flächen an der Unterseite 
anwählen (Abb. 4) und mit [E | 1], [E | 0.5] und 
[E | 1] extrudieren.

• Die untersten Flächen (Faces) auf der Vorder-
seite anwählen und mit Subdivide unterteilen. 
(Tool Shelf / [W]-Specials-Menü, Abb. 5)
• Die untersten Edges anwählen und entlang 
der Y-Achse nach vorne ziehen. (Füsse)
• Bei den Knien eine Unterteilung vornehmen: 
im Tool Shelf den Loop Cut and Slide ankli-
cken, mit dem Mauszeiger an den Rand der 
Beine gehen, linksklicken und anschliessend 
rechtsklicken. (so schnappt der Loop Cut ex-
akt in die Mitte) 
• Diese neue Unterteilung mit [S | 1.2] vergrös-
sern. (Abb. 6)

Abb. 2

Abb. 3

Abb. 4

Abb. 5
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• Das selbe (Loop Cut und Vergösserung) bei 
den Ellbogen machen.
• Die Flächen für den Hals anwählen und mit [E 
| 0.2] und [E | Enter] extrudieren. (Abb. 7)
• Die Auswahl mit [S | 1.5] skalieren und 
schliesslich mit [E | 1] extrudieren. (Abb. 8)

Abb. 6

Abb. 7

• Die beiden Hand-Flächen anwählen und mit 
Insert Faces (links im Tool Shelf) unterteilen.
• Diese neuen Flächen mit [E | 0.3] extrudieren 
und die Auswahl behalten.
• Beim Pivot Point (oberhalb Timeline) vorüber-
gehend von der Einstellung Median Point zu 
Individual Origins wechseln. (Abb. 9)
• Jetzt die Auswahl mit [S | 1.5] vergrössern. 
(Abb. 10)
• Weitere Korrekturen bezüglich der Form 
können über das Anwählen und Verschieben 
einzelner Vertices, Edges oder Faces realisiert 
werden.

Abb. 8 Abb. 10

Abb. 9
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Abb. 1

Mit Low-Poly sind 3D-Computergrafik-Körper 
gemeint, welche mit einer tiefen Anzahl Poly-
gonen (also Flächen, in Blender: Faces) aus-
kommen. Diese Polygone wiederum haben 
meist nur das Minimum an Eckpunkten, also 
drei.  Low-Poly Objekte sind nicht rechenin-
tensiv und können von der Slicer-Software be-
sonders schnell für den 3D-Druck aufbereitet 
werden. Auch bei Renderings sparen Low-Po-
ly-Objekte Berechnungszeit ein.

• Den Standardwürfel mit [X] löschen und mit 
[shift_A] eine Ico-Sphere hinzufügen.
• Unten links im Tool Shelf [T] die Size auf 4 
stellen. (Faktor 4, ergibt 8 cm Durchmesser)
• Mit [Tabulator] in den Edit Mode wechseln 
und mit [3] und [5] in die orthogonale Seiten-
ansicht gehen. 
• Den obersten Punkt mit [X] löschen. (Delete 
Vertices)
• Den untersten Punkt entlang der Z-Achse 
nach oben schieben. (ergibt die Standfläche)
• Nach Belieben: Den gesamten Becher mit [A] 
anwählen und mit [S I Z I 1.6] länger skalieren. 
(Abb. 1)
• Mit [7] in die Top-Ansicht wechseln und den 
obersten Kantenring mit [alt_Linksklick] aus-
wählen. (Abb. 2)

• Mit [3] in die Seitenansicht wechseln.
• Oberhalb der Timeline den Proportional 
Editing Mode aktivieren. (Enable)
• Den ausgewählten Kantenring mit [R I Z I 50] 
rotieren. Dabei den Auswahl-Bereich des Pro-
portional Editing Modes mit dem Maus-Scroll-
rad bestimmen.
• Analog den untersten Kantenring auswählen 
und diesen in der Seitenansicht mit [R I  Z I -50] 
entlang der Z-Achse rotieren.

Abb. 2
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• Nach Belieben: einzelne Kantenringe anwäh-
len und mit [S], [G] oder [R] manipulieren. Da-
bei kann mit oder ohne Proportional Editing 
Mode (PEM) gearbeitet werden. 
• Mit [Tabulator] zurück in den Object Mode 
wechseln und am rechten Rand beim Schrau-
benschlüsselsymbol den Modifier Solidify ho-
len. Die Thickness kann auf 0.3 gestellt wer-
den. Den Modifier mit Apply anwenden.

Abb. 4

• Alternativ zur Ausgangslage mit dem Mesh-
Objekt kann mit dem Remesh-Modifier (beim 
Schraubenschlüssel-Symbol) gearbeitet wer-
den, welcher unter dem Wert Octree Depth 
ebenfalls eine tiefe Anzahl Polygone ermög-
licht.
• Weiter können auch im Edit Mode mit [ctrl_
Rechtsklick] einzelne Vertices gesetzt und 
schliesslich mit [F] zu einem Gitternetz ver-
bunden werden. (Abb. 4) Das Messer (Knife 
im Tool Shelf) ermöglicht ein Mesh manuell zu 
unterteilen.

Abb. 3
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Abb. 1

Abb. 3

Ein weiterer Weg in Blender zu Modellie-
ren besteht darin, den halben Querschnitt 
des gewünschten Objekts im Edit Mode mit 
[ctrl_Rechtsklick] zu zeichnen und diesen mit 
der Funktion Spin (Tool Shelf) zu einem drei-
dimensionalen Körper zu drehen. (Abb. 1 und 
2) Dabei ist wichtig, dass in der orthogonalen 
Ansicht  [5] gezeichnet wird, in der Flucht-
punktperspektive entstehen Ungenauigkeiten. 

Abb. 2

Da das Objekt auch nach einer 360° Drehung 
nicht richtig geschlossen ist, müssen mit Re-
move Doubles die doppelten Kontrollpunkte 
(Vertices) entfernt werden. (Abb. 3) 

Um dem Rotationskörper eine glatte Oberflä-
che zu verleihen, kann entweder die Funktion 
Shade Smooth oder Subdivision Surface an-
gewendet werden. Shade Smooth glättet die 
Geometrie nicht wirklich, sondern nur deren 
Erscheinung und kommt bei Renderings zum 
Einsatz. Soll die Oberfläche beim 3D-Druck 
sein, so muss die Funktion Subdivision Sur-
face (zu finden bei den Properties) angewendet 
werden. Diese verfeinert die Geometrie indem 
sie dem Objekt mehr Gitterpunkte, Kanten und 
Flächen hinzufügt.
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Abb. 1

• Den Standardwürfel (Cube) anwählen und mit 
[Tabulator] in den Edit Mode wechseln.
• Im Edit Mode mit [A] alles auswählen und mit 
[X] alles löschen (Delete Vertices).
• Mit [5] und [3] in die orthogonale Seitenan-
sicht wechseln.
• Mit [ctrl_Rechtsklick] einzelne Punkte setzen 
und so die äussere Silhouette eines Kreisels 
zeichnen. Analog funktioniert eine Vase oder 
ein Weinglas. Der 3D-Cursor (rot-weisses Fa-
denkreuz) am Nullpunkt kann als Drehzentrum 
angesehen werden. Ist der 3D-Cursor nicht 
am Nullpunkt, so kann er mit [shift_S] Cursor 
to Center gebracht werden. (Abb. 1)

• Mit [7] in die Top-Ansicht wechseln.
• Mit [A] alles auswählen und viermal die Funk-
tion Spin klicken. (links im Tool Shelf zu finden)
• Mit [A] alles auswählen und die Funktion Re-
move Doubles klicken. (ebenfalls links im Tool 
Shelf zu finden, Abb. 2)

• Um den Boden zu schliessen: Einzoomen, 
eine der untersten Edges (Kanten) anwählen 
und unter Select den Edge Loops klicken. (Op-
tional mit [alt_Linksklick]) Diesen angewählten 
Kantenring mit [F] schliessen. (Abb. 3)
• Alles anwählen [A] unter Mesh - Normals - 
Recalculate Outside klicken. (Abb. 4)

Abb. 2

Abb. 3
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• Mit [Tabulator] in den Object Mode wechseln.
• Nach Belieben bei den Properties den Modi-
fier Subdivision Surface aktivieren. Die Anzahl 
der Unterteilungen einstellen und den Modifier 
mit Apply anwenden. (Abb. 5)

Abb. 4

Abb. 5

• Um bei Vasen, Gläsern und ähnlichem Wand-
stärke zu generieren, muss mit dem Solidify-
Modifikator gearbeitet werden. Die Tickness 
kann beispielsweise auf 0.2 gestellt werden.  
Wiederum den Modifikator mit Apply anwen-
den. (Abb. 6) 

Abb. 6
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Abb. 1

Curves sind Linien, die mit Hilfe von Anker-
punkten (in Blender Vertices) und Griffen ver-
formt werden können. Einzelne Punkte werden 
im Edit Mode mit [ctrl_Rechtsklick] gesetzt. 
(Abb. 1) Anfangs- und Endpunkt werden mit 
[F] verbunden. Mit [X] können einzelne Punkte 
wieder gelöscht werden.

Bei den Properties unter dem Curve-Symbol 
kann unter Resolution die Anzahl Segmente 
des Curves eingestellt werden, diese bestim-
men die Auflösung des virtuellen Objektes. 
Mittels Extrude (ebenfalls unter dem Curve-
Symbol) werden die Punkte in den Raum ge-
zogen und so dreidimensionalisiert. (Abb. 2) 
Um Curve-Objekte 3D zu drucken, müssen sie 
mit [alt_C] zu einem druckbaren Mesh-Objekt 
konvertiert werden. (Abb. 3)

Abb. 2

Abb. 3
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Abb. 1

• Den Standardwürfel mit [X] löschen und mit 
[shift_A] einen Curve Circle und einen Bezier 
Curve hinzufügen.
• Den Bezier Curve mit Linksklick anwählen 
und mit [R | X | 90] um 90° entlang der X-Achse 
rotieren.
• Den Curve Circle anwählen und rechts bei 
den Properties auf das Curve Icon klicken. Un-
ter Geometry bei Bevel Object den Bezier Cur-
ve einstellen. (Abb. 1)
• Mit [5 | 1] in die orthogonale Front-Ansicht 
wechseln.
• Mit [G] den Bezier Curve an den Rand des 
entstandenen Objektes verschieben. Dazu mit 
[Z] in die Wireframe-Ansicht wechseln. (Abb. 2)

• Mit dem Bezier Curve in den Edit Mode wech-
seln. [Tabulator]
• Den Bezier Curve mit Hilfe der Kontrollpunk-
te und Griffe zum erwünschten Objekt ziehen.  
(Abb. 3) Verschiedene Griffe können links im 
Tool Shelf oder mit [V] definiert werden. Weite-
re Punkte können mit Subdivide hinzugefügt, 
überschüssige Punkte können mit [X] gelöscht 
werden. Beim Curve Icon kann unter Shape 
die Resolution (Preview) eingestellt werden, 
diese regelt die Anzahl Segmente des Curves.

• Sobald die erwünschte Form modelliert ist, 
kann mit [Tabulator] zurück in den Object 
Mode gewechselt werden.
• Mit [alt_C] > (Mesh from Curve/Meta/Surf/
Text) wird aus dem nicht druckbaren Curve-
Objekt ein druckbares Mesh-Objekt
• Um einen Boden oder Deckel zu schliessen, Abb. 2

Abb. 3
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kann mit [Tabulator] in den Edit Mode gewech-
selt werden, der entsprechende Kantenring 
kann mit [alt_Linksklick] ausgewählt und mit 
[F] verbunden werden. Falls diese neue Fläche 
nicht plan gespannt ist, kann sie mit [ctrl_T] in-
dividuell trianguliert werden. (Abb. 4)

• Das Objekt mit [A] anwählen und die Flächen-
normalen mit [ctrl_N] neuberechnen lassen. 
(Optional ist diese Funtkion unter Mesh > Nor-
males > Recalculate Outside zu finden)
• Für die Wandstärke kann im Object Mode der 
Modifikator Solidify aktiviert werden. Thick-
ness ermöglicht einen genauen Wert für die 
Wandstärke zu definieren. Schliesslich den 
Modifikator mit Apply anwenden. (Abb. 5, 6)

Abb. 4

Abb. 5

Abb. 6
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kann mit [Tabulator] in den Edit Mode gewech-
selt werden, der entsprechende Kantenring 
kann mit [alt_Linksklick] ausgewählt und mit 
[F] verbunden werden. Falls diese neue Fläche 
nicht plan gespannt ist, kann sie mit [ctrl_T] in-
dividuell trianguliert werden. (Abb. 4)

• Das Objekt mit [A] anwählen und die Flächen-
normalen mit [ctrl_N] neuberechnen lassen. 
(Optional ist diese Funtkion unter Mesh > Nor-
males > Recalculate Outside zu finden)
• Für die Wandstärke kann im Object Mode der 
Modifikator Solidify aktiviert werden. Thick-
ness ermöglicht einen genauen Wert für die 
Wandstärke zu definieren. Schliesslich den 
Modifikator mit Apply anwenden. (Abb. 5, 6)

Abb. 4

Abb. 5

Abb. 6



MODUL: MODELLIEREN MIT CURVES

3D-Modellieren und 3D-Drucken mit Blender | S. Mauroux

TÜRSTOPPER | s. 1 / 2

Abb. 1

• Den Standardwürfel mit [X] löschen.
• Im Add-Menü [shift_A] unter Curve eine Be-
zier-Kurve holen.
• Die Bezier-Kurve anwählen und mit [Tabula-
tor] in den Edit Mode wechseln.
• Mit [5] und [7] in die orthogonale Ansicht von 
oben wechseln.
• Einzelne Punkte mit [ctrl_Rechtsklick] hinzu-
fügen.
• Mit [V] können verschiedene Arten von Grif-
fen definiert werden. (Spitze Ecke: Vector)
• Die Form schliessen: den Anfangs- und den 
Endpunkt anwählen (Mehrfach-Auswahlen mit 
gehaltener Shift-Taste) und mit [F] verbinden. 
(Abb. 1)

• Beim Curve-Icon am rechten Rand unter 
Shape von 3D auf 2D umstellen. So erscheint 
innerhalb der gesetzten Punkte eine graue Flä-
che.
• Ausnahmsweise im Edit Mode unter Add ei-
nen Curve - Circle hinzufügen. Sobald dieser 

Circle mit der grauen Fläche deckungsgleich 
ist, kann er als Hohlform verwendet werden. 
(optional die bereits modellierte Form anwäh-
len und mit [shift_D] duplizieren)
• Am rechten Rand beim Curves-Icon kann 
unter Geometry > Extrude die Fläche in den 
Raum extrudiert werden. Mit Bevel werden die 
Kanten gebrochen, Resolution bestimmt die 
Auflösung von diesen neuen Kanten. (Abb. 2)
• Mit [Tabulator] in den Object Mode wechseln. 
• Unter Object > Convert to > Mesh from Cur-
ve/Meta/Surf/Text klicken. So wird das Curve-
Objekt zu einem 3D-druckbaren Gitternetz-
Objekt. (Abb. 3)

Abb. 2
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• Sind die Flächennormalen verdreht, muss im 
Edit Mode mit [A] alles angewählt werden und 
mit [ctrl_N] die Normalen der Aussenseite neu 
berechnet werden lassen. (Abb. 4)

Abb. 4

Abb. 3
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Abb. 1

• Den Standardwürfel mit [X] löschen.
• Im Add-Menü [shift_A] unter Curve eine Be-
zier-Kurve holen.
• Die Bezier-Kurve anwählen und mit [Tabula-
tor] in den Edit Mode wechseln.
• Mit [5] und [7] in die orthogonale Ansicht von 
oben wechseln.
• Wenn nötig im Properties-Shelf [N] Back-
ground Images aktivieren und ein erwünschtes 
Hintergrund-Bild definieren.
• Einzelne Punkte mit [ctrl_Rechtsklick] hin-
zufügen. (Braucht es zwischen zwei Punkten 
noch mehr Punkte, kann dies mit Subdivide 
im Tool Shelf erreicht werden. Überschüssige 
Punkte (Vertices) können angewählt und mit [X] 
entfernt werden.)
• Form schliessen: den Anfangs- und Endpunkt 
anwählen (Mehrfach-Auswahlen mit gehalte-
ner Shift-Taste) und mit [F] verbinden. (Abb. 1)
• Das Background Image kann nun wieder ent-
fernt werden (abhäkeln).

Ab hier gibt es zwei Möglichkeiten.
Variante 1: (oben und unten gleicher Durch-
messer)
• Im Edit Mode beim Curve-Icon (rechter Rand) 
unter Geometry auf Extrude klicken. Auf den 
Wert 1 extrudieren (ergibt 2 cm). (Abb. 2)
• Mit [Tabulator] in den Object Mode wechseln 
und unter Object > Convert to > Mesh from 
Curve/Meta/Surf/Text klicken. 
• Rechts beim Schraubenschlüssel-Symbol 
den Modifier namens Solidify holen und die 
Thickness auf  0.1 (= 1 mm) stellen. Den Modi-
fier mit Apply anwenden. (Abb. 3)

Abb. 2

Abb. 3

MODUL: MODELLIEREN MIT CURVES

3D-Modellieren und 3D-Drucken mit Blender | S. Mauroux

AUSSTECHFORM | s. 2 / 2

Variante 2: (oben einen dickeren Rand)
• Im Object Mode mit [shift_A] einen Curve Cir-
cle hinzufügen.
• Die Ausstechform anwählen und bei den Pro-
perties das Curve-Icon anklicken. Unter Geo-
metry den Circle (Bezier Circle) definieren. So 
wird der Circle um die modellierte Form gewi-
ckelt / extrudiert. (Abb. 4)

• Mit dem Circle in den Edit Mode wechseln. 
[Tabulator]
• Mit [5] und [7] in die orthogonale Top-Ansicht 
wechseln.
• Über das Verschieben der Vertices die rechts 
abgebildete Form modellieren. Für den spit-
zen, unteren Teil kann der unterste Punkt an-
gewählt und mit [V] der Handle Type auf Vector 
umgestellt werden. (Abb. 5)
• Links im Tool Shelf kann unter Grease Pencil 
der Ruler/Protactor aktiviert werden. Nur in der 
orthogonalen Ansicht messen und möglichst 
nahe an das Objekt heranzoomen. 

Abb. 4

Abb. 6

Abb. 5

• Allenfalls den deformierten Circle mit [A] an-
wählen und mit [S] zur erwünschten Grösse 
skalieren. Eine Länge von 2 (= 2 cm) und eine 
mittlere dicke von 1.5 mm empfiehlt sich hier.
• Mit [Tabulator] in den Object Mode wechseln.
• Die Guetzli-Ausstech-Form anwählen und mit 
[alt_C] das Curve Objekt zu einem Gitternetz-
Objekt konvertieren. (Mesh from Curve/Meta/
Surf/Text)
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Variante 2: (oben einen dickeren Rand)
• Im Object Mode mit [shift_A] einen Curve Cir-
cle hinzufügen.
• Die Ausstechform anwählen und bei den Pro-
perties das Curve-Icon anklicken. Unter Geo-
metry den Circle (Bezier Circle) definieren. So 
wird der Circle um die modellierte Form gewi-
ckelt / extrudiert. (Abb. 4)

• Mit dem Circle in den Edit Mode wechseln. 
[Tabulator]
• Mit [5] und [7] in die orthogonale Top-Ansicht 
wechseln.
• Über das Verschieben der Vertices die rechts 
abgebildete Form modellieren. Für den spit-
zen, unteren Teil kann der unterste Punkt an-
gewählt und mit [V] der Handle Type auf Vector 
umgestellt werden. (Abb. 5)
• Links im Tool Shelf kann unter Grease Pencil 
der Ruler/Protactor aktiviert werden. Nur in der 
orthogonalen Ansicht messen und möglichst 
nahe an das Objekt heranzoomen. 

Abb. 4

Abb. 6

Abb. 5

• Allenfalls den deformierten Circle mit [A] an-
wählen und mit [S] zur erwünschten Grösse 
skalieren. Eine Länge von 2 (= 2 cm) und eine 
mittlere dicke von 1.5 mm empfiehlt sich hier.
• Mit [Tabulator] in den Object Mode wechseln.
• Die Guetzli-Ausstech-Form anwählen und mit 
[alt_C] das Curve Objekt zu einem Gitternetz-
Objekt konvertieren. (Mesh from Curve/Meta/
Surf/Text)
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Abb. 1

• Den Standardwürfel im Fenster für numeri-
sche Werte [N] zu einem länglichen Quader 
skalieren (= Gesamtgrösse von Schlüsselan-
hänger, z.Bsp. X= 7 cm, Y= 2.5 cm, Z= 0.3 cm) 
• Allenfalls diesen Quader mit [Tabulator] in den 
Edit Mode nehmen und mit [ctrl_B] die Kanten 
brechen. Dieser Vorgang kann mehrmals wie-
derholt werden. Anschliessend zurück in den 
Object Mode wechseln. (Abb. 1)

• Im Object Mode unter dem Menü Add einen 
Cylinder hinzufügen.
• Diesen Cylinder mit [S] kleiner skalieren 
(z.Bsp. X / Y / Z = 0.6 cm), deutlich mit dem 
Quader überschneiden und mit Hilfe des 
Boolean Modifiers (Difference) vom Quader 
abziehen. (Abb. 2, Optionale Befestigungs-
möglichkeit: am Rand des Quaders ein Torus 
hinzufügen. Hier müsste der Boolean Modifier 
Union angewendet werden.)
• Den Hilfs-Cylinder mit [X] löschen.

• Im Add-Menü ein Text-Objekt holen und mit 
[Tabulator] in den Edit Mode wechseln.
• Mit der Löschtaste den Beispieltext löschen 
und eigene Buchstaben eintippen.
• Am rechten Rand auf das Text-Icon (ein F 
wie Font) klicken. Unter Font kann die Grösse 
(Font - Size) verändert werden, Shear ermög-
licht eine Schrägstellung der Buchstaben. Text 
on Curve ermöglicht, den Text entlang einer 
Kurve rund anzuordnen. Unter Geometry kann 
mit Extrude die Schrift dreidimensionalisiert 
werden. Rechts von Extrude können unter Be-
vel Depth die Kanten des Schriftzugs gebro-
chen werden. (Abb. 3)

Abb. 2

Abb. 3
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• Mit [Tabulator] in den Object Mode wechseln 
und die Datei speichern (File - Save as).
• Das Textobjekt anwählen und unter Object - 
Convert to - Mesh from Curve/Meta/Surf/Text 
klicken. So wird aus diesem nicht druckbaren 
Curve-Objekt ein druckbares Mesh-Objekt.
• Mit [Tabulator] in den Edit Mode wechseln, al-
les anwählen und links im Tool Shelf die Funk-
tion Remove Doubles klicken. (Abb. 4, optional 
im Specials-Menü [W])

• Wieder mit [Tabulator] zurück in den Object 
Mode wechseln und den Text mittels Boolean 
Modifier Union oder Difference mit dem längli-
chen Quader (aus dem 1. Teil der Übung) ver-
einen. (Abb. 5)
• Analog funktionieren Visitenkarten, Namens-
schilder und ähnliches. Mit dem Boolean Mo-
difier Difference kann die Schrift auch zum 

Abb. 4

Abb. 6

Abb. 5

durchstossen eines Körpers verwendet wer-
den. Mit der Stencil-Schrift fallen keine inneren 
Teile der Buchstaben weg. 
• Für den 3D-Druck exportieren: Objekt an-
wählen > File > Export > STL und im neuen 
Fenster die Scale auf 10 stellen.
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Abb. 1

• Unter File > User Preferences > Addons auf 
der linken Seite zur Kategorie Object gehen 
und dort das Addon namens Cell Fracture 
anhäkeln. Danach die Einstellungen mit Save 
User Settings speichern. (Abb. 1)

• Ein Mesh- Objekt mit [shift_A] in die Szene 
einfügen und links im Tool Shelf unter Edit auf 
Cell Fracture klicken.
• Im neuen Fenster können die folgenden Ein-
stellungen vorgenommen werden: (Abb. 2)
Zuoberst bei Point Source kann definiert wer-
den, aus welchen Punkten die Voronoi-Regi-
onen berechnet werden sollen. Neben den 
eigenen Punkten vom Objekt, können auch 
untergeordnete Objekte, Partikel oder ein 
Strich mittels Grease Pencil als Ausgangslage 
gewählt werden. Wichtig ist die Source Limit, 
hier kann die obere Grenze der zu bildenden 
Regionen festgelegt werden. Weiter spannend 
ist die Angabe Noise, welche zusätzliche Un-

regelmässigkeiten einbringt. Gleich unterhalb 
von Noise können mit Scale die Seitenverhält-
nisse (entlang X, Y, Z) verändert werden. Der 
Wert Margin (in der Mitte) regelt den Abstand 
zwischen den einzelnen Regionen / Bruchstü-
cken. Mit OK werden die Voronoi-Regionen 
berechnet.

• Oberhalb der Timeline in die zweite Ebene 
wechseln (Abb. 3), alle einzelnen Teile anwäh-
len und mit [ctrl_J] zu einem Objekt zusam-
menfügen. 

Abb. 2

Abb. 3
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• Mit [alt_C] das Objekt zu einem Curve-Objekt 
konvertieren. (Curve from Mesh/Text, Abb. 4)
• Mit [shift_A] einen Curve - Circle hinzufügen 
und diesen mit [S] kleiner skalieren. 
• Dem Haupt-Objekt auf der rechten Seite  
beim Curve-Symbol unter Geometry als Bevel 
Object den Curve-Circle einfügen und allen-
falls mit [S] die Skalierung optimieren. (Abb. 5)

Abb. 4

Abb. 8

• Schliesslich das Objekt wieder mit [alt_C] zu 
einem druckbaren Mesh- Objekt konvertieren. 
(Abb. 6)
• Im Edit Mode mit Remove Doubles [W] die 
doppelten Punkte löschen und mit [ctrl_N] die 
Flächennormalen der Aussenseite neuberech-
nen lassen. (Abb. 7)

Abb. 7

Abb. 5

Abb. 6
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• Mit [alt_C] das Objekt zu einem Curve-Objekt 
konvertieren. (Curve from Mesh/Text, Abb. 4)
• Mit [shift_A] einen Curve - Circle hinzufügen 
und diesen mit [S] kleiner skalieren. 
• Dem Haupt-Objekt auf der rechten Seite  
beim Curve-Symbol unter Geometry als Bevel 
Object den Curve-Circle einfügen und allen-
falls mit [S] die Skalierung optimieren. (Abb. 5)

Abb. 4

Abb. 8

• Schliesslich das Objekt wieder mit [alt_C] zu 
einem druckbaren Mesh- Objekt konvertieren. 
(Abb. 6)
• Im Edit Mode mit Remove Doubles [W] die 
doppelten Punkte löschen und mit [ctrl_N] die 
Flächennormalen der Aussenseite neuberech-
nen lassen. (Abb. 7)

Abb. 7

Abb. 5

Abb. 6
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Abb. 1

• Den Standardwürfel mit [X] löschen und mit 
[shift_A] eine Ico Sphere hinzufügen. Die An-
zahl Subdivisions auf 2 stellen. (Bei neu hin-
zugefügten Objekten lassen sich im Tool Shelf 
Veränderungen bezüglich den Unterteilungen 
vornehmen.)
• Mit [Tabulator] in den Edit Mode wechseln.
• [W] öffnet das Specials-Menü, hier kann Be-
vel aktiviert werden (Tastenkürzel [ctrl_B]). So 
gelingen neue, spannende Unterteilungen. 
(Abb. 1, Beim FDM-Druck empfiehlt es sich al-
lerdings nicht unzählige, feine Unterteilungen 
zu machen.)

• Mit [3] und [5] in die orthogonale Seitenan-
sicht wechseln. 
• Den Proportional Editing Mode (PEM) ein-
schalten (Enable).
• Mit [Z] die Wireframe-Ansicht aktivieren.
• Den obersten Punkt mit der linken Maustaste 

auswählen. Diese Auswahl entlang der Z-Ach-
se nach unten ziehen, dabei mit dem Mausrad 
den Einflussbereich des Proportional Editing 
Mode bestimmen. (Abb. 2)

• Den untersten Punkt anwählen und entlang 
der Z-Achse hochziehen, so dass es einen fla-
chen Boden gibt. (Dazu den PEM ausschalten)
• Den inneren Kantenring mit gehaltener Shift-
Taste auswählen. Diese Auswahl in der [3]-An-
sicht entlang der Z-Achse nach unten ziehen. 
Dazu muss wieder mit [Z] die Wireframe-An-
sicht aktiviert werden.
• Mit [Z] in die Gitternetz-Ansicht wechseln-
mit [B] ein Auswahlrechteck aufziehen und die 
oberen zwei Kantenringe auswählen.
• Mit [S] diese Auswahl vergrössern und allen-
falls mit [G] verschieben. (Abb. 3)

Abb. 2

Abb. 3
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• Den Proportional Editing Mode mit [O] wieder 
ausschalten (Disable).

Ab hier gibt es zwei mögliche Varianten:

Variante 1 (eckige Verbindungen)
• Mit [Tabulator] in den Object Mode wechseln.
• Beim Schraubenschlüsselsymbol den Modi-
fier namens Wireframe aktivieren. Die Thick-
ness kann auf 0.1 gestellt werden. Mit Apply 
den Modifier anwenden. (Abb. 4 und 5)

Abb. 4

Abb. 7

Variante 2 (runde Verbindungen)
• Alles anwählen mit [A] und mit [X] Only Faces 
löschen. (Edit Mode)
• Mit [Tabulator] in den Object Mode wechseln.
• Mit [alt_C] das Objekt zu einem Curve Objekt 
konvertieren. (Abb. 6, Curve from Mesh/Text)

• Mit [shift_A] einen Curve Circle hinzufügen 
und mit [S] kleiner skalieren.
• Die Schale anwählen und rechts im Proper-
ties Panel auf das Curve-Symbol klicken. 
• Unter Geometry als Bevel Object den Circ-
le definieren. Allenfalls jetzt wieder den Circle 
anwählen und mit [S] zur gewünschten Grösse 
skalieren. (Abb. 7)

Abb. 5

Abb. 6
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• Mit [alt_C] aus dem Curve-Objekt wieder ein 
Mesh-Objekt machen (Abb. 8, Mesh from Cur-
ve/Meta/Surf/Text)
• Mit [Tabulator] in den Edit Mode wechseln, 
alles anwählen und auf Remove Doubles kli-
cken. (Tool Shelf)
• Mit [ctrl_N] die Flächennormalen neu berech-
nen lassen.

Abb. 9

Abb. 8



MODUL: MODELLIEREN MIT META-OBJEKTEN

3D-Modellieren und 3D-Drucken mit Blender | S. Mauroux

 s. 1 / 2

Abb. 1

Meta-Objekte unterscheiden sich stark von 
Mesh-Objekten. Sie beschreiben vorerst keine 
druckbaren Objekte, sondern Einflussregionen 
um welche eine virtuelle Membran gespannt 
wird. Aufgrund der runden Formen eignen 
sich Meta-Objekte ideal für das Modellieren 
von organischen Körpern. Blender bietet 5 
verschiedene Meta-Objekte als Grundformen 
an: Ball, Capsule, Plane, Ellipsoid und Cube. 
(Abb. 1) Mit [alt_C] werden Meta-Objekte zu 
Mesh-Objekten konvertiert und erhalten so ein 
druckbares Gitternetz. Die Geometrie dieses 
Netzes kann (je nach Beschaffenheit) mit dem 
Remesh-Modifier aufgeräumt werden.

Der Proportional Editing Mode (PEM) er-
möglicht im Edit Mode neben den selektierten 
Punkten (Kanten oder Flächen), umliegende 
Punkte (Kanten und Flächen) proportional mit-
zubeeinflussen. Der Einflussbereich kann mit 
dem Maus-Scrollrad bestimmt und verschie-

dene Arten der Beeinflussung (Falloffs) einge-
stellt werden. (Abb.3) Der Tastenkürzel für das 
Einschalten (Enable) und Ausschalten (Disable) 
des PEM ist [O]. (Abb. 2)

Neben dem Object und Edit Mode gibt es 
weiter den Sculp Mode in Blender. Im Un-
terschied zum Edit Mode werden hier keine 
einzelnen Punkte, Kanten oder Flächen hinzu-
gefügt und bearbeitet, sondern mit den vor-
handenen Flächen gearbeitet. Das heisst, vor 
dem Wechseln in den Sculp Mode sollte das 
Objekt genügend einzelne Flächen aufweisen 

Abb. 2

Abb. 3
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(Mehr einzelne Flächen = mehr Manipulations-
möglichkeiten). Dazu kann im Object Mode der 
Modifikator Subdivision Surface oder im Edit 
Mode die Funktion Subdivide angewendet 
werden. Im Sculp Mode können innerhalb vom 
Einflussbereich die vorhanden Flächen ent-
lang der Flächennormalen hinauf- (Add) oder 
heruntergezogen (Substract) werden. Der Ein-
flussbereich kann links im Tool Shelf [T] unter 
Radius oder mit dem Tastenkürzel [F] bestimmt 
werden. Weiter kann unter Strength die Stärke 
der Manipulation definiert werden. (Abb. 4)

Es stehen verschiedene Arten der Beeinflus-
sung (Brushes) zur Verfügung. Sculpt/Draw 
ist in der Standarddeinstellung, damit lassen 
sich die meisten Veränderungen realisieren. 
Blob ermöglicht, blasen- oder buckelartige 

Abb. 4

Abb. 5

Auswüchse zu formen, Clay füllt Löcher und 
glättet. Crease eignet sich zum Modellieren 
von Narben. Fill/Deepen ermöglicht entweder 
Löcher zu vertiefen oder wieder aufzufüllen. 
Weiter kann im Tool Shelf unter Symmetrie/
Lock das Spiegeln entlang bestimmter Achsen 
und / oder das Sperren von einzelnen Achsen 
geregelt werden. (Abb. 5) 
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Abb. 1

Grobe Form mit Metaobjekten:
• Den Standardwürfel mit [X] löschen.
• Im Add-Menü unter Metaball einen Ball holen.
• Am rechten Rand beim Metaball-Icon die Re-
solution in der View auf 0.150 stellen. (Abb.1)
• Wenn nötig: Mit [N] das Properties Shelf ho-
len und unter Background Image ein Hinter-
grundbild einstellen. (Allenfalls das Bild mit Hil-
fe der Optionen im Properties Shelf zoomen, 
verschieben oder rotieren. Abb. 2)
• Mit [1] und [5] in die orthogonale Ansicht von 
vorne wechseln.

• Mit [shift_D] den Ball duplizieren und jeweils 
mit [S | X / Z] entlang einzelner Achsen verän-
dern.
• Die Meta-Objekte wie gewünscht arrangieren
und in der orthogonalen Ansicht von vorne 
bleiben. (Abb. 3)
• Bei symmetrischen Objekten kann vorerst 
eine Hälfte modelliert und im zweiten Schritt 
gespiegelt werden (wird unten erläutert).
• Das Objekt in dieser Form als Blender-File 
abspeichern.

Ausbesserung mit dem Proportional Editing 
Mode:
• Dazu muss das Meta-Objekt mit [alt_C] zu 
einem Mesh-Objekt (Mesh from Curve/Meta/
Surf/Text) konvertiert werden.
• Das Objekt kann nun mit Linksklick ange-
wählt und damit in den Edit Mode gewechselt Abb. 2

Abb. 3
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werden. [Tabulator]
• Mit [O] lässt sich der Proportional Editing 
Mode einschalten.
• Jetzt können mithilfe des PEM Korrekturen 
bezüglich der Form vorgenommen werden, 
dabei am besten zwischen der orthogonalen 
Ansicht von vorne [5 | 1] und von rechts [3] 
wechseln.  [ctrl | 1] ermöglicht die Ansicht von 
hinten, [ctrl | 3] von links. (Abb. 4)
• Mehrere Punkte gleichzeitig können mit der 
Circle Select [C] oder mit der Border Select [B]
ausgewählt werden.

Abb. 4

Abb. 5

• Wenn nötig kann nun das Objekt zuerst mit 
[shift_D | Enter] dupliziert und mit [ctrl_M | X / 
Y / Z] entlang der gewünschten Achse gespie-
gelt werden. (Abb. 5)
• Beide Teile korrekt mit dem Boolean Modifier 
vereinen. (Operation: Union)

Gesicht mit dem Sculp Mode:
• Im Edit Mode mit [B] das Gesicht auswäh-
len und die Auswahl (mindestens) zweimal mit 
Subdivide (links im Tool Shelf) unterteilen.
• In den Sculp Mode wechseln. (Abb.6)

Abb. 6
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• Mit [5] und [1] in die orthogonale Ansicht von 
vorne wechseln.
• Für das Gesicht kann im Tool Shelf die Funk-
ton Symmetrie zur Spiegelung genutzt werden. 
(Entlang der X-Achse)
• Mit der Sculp/Draw Brush eine Nase formen 
(Add). Für die Nasenlöcher Subtract verwen-
den.
• Mit der Sculp/Draw Brush Lippen formen, die 
Vertiefung wiederum mit Subtract machen. Die 
Lippen mit der Grab Brush näher zusammen-
ziehen.
• Mit der Sculp/Draw Brush und grossem Ra-
dius ein Kinn formen. Mit der selben Brush die 
Erhöhung für die Stirn und die Augenbrauen 
formen. (Abb. 7)

MENSCHLICHER KÖRPER | s.  3 / 3

• Nach dem Modellieren in den Edit Mode 
wechseln und die Funktion Remove Doubles 
anwenden. (Links im Tool Shelf oder mit [W] im 
Specials-Menü, Abb. 8)

Abb. 7

Abb. 8
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• Mit [5] und [1] in die orthogonale Ansicht von 
vorne wechseln.
• Für das Gesicht kann im Tool Shelf die Funk-
ton Symmetrie zur Spiegelung genutzt werden. 
(Entlang der X-Achse)
• Mit der Sculp/Draw Brush eine Nase formen 
(Add). Für die Nasenlöcher Subtract verwen-
den.
• Mit der Sculp/Draw Brush Lippen formen, die 
Vertiefung wiederum mit Subtract machen. Die 
Lippen mit der Grab Brush näher zusammen-
ziehen.
• Mit der Sculp/Draw Brush und grossem Ra-
dius ein Kinn formen. Mit der selben Brush die 
Erhöhung für die Stirn und die Augenbrauen 
formen. (Abb. 7)
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• Nach dem Modellieren in den Edit Mode 
wechseln und die Funktion Remove Doubles 
anwenden. (Links im Tool Shelf oder mit [W] im 
Specials-Menü, Abb. 8)

Abb. 7

Abb. 8
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Abb. 1

• nur Mesh-Objekte drucken 
Nur Gitternetz-Objekte sind 3D-druckbar. Cur-
ve, Text, Surface oder Meta-Objekte zuerst im 
Object Mode mit [alt_C] zu einem Mesh-Objekt 
konvertieren.  Optional unter Object > Convert 
to. 

• steile oder überhängende Regionen ver-
meiden (bei FDM)
Ansonsten ab 45° / 60° in der Slicer-Software 
unbedingt das Generieren von Stützstrukturen 
aktivieren. (Make Support)

• genügend Wandstärke
Im Object Mode mit dem Modifier namens 
Solidify arbeiten. Allenfalls im Edit Mode ein-
zelne dünne Teile anwählen und die Funktion 
Shrink/Fatten (Tool Shelf) nutzen. (Abb. 1) In 
der Slicer-Software die Stärke  der Aussenhül-
le (Shells) definieren. 

• keine Flächen, Kanten, Punkte im Innern 
eines 3D-Körpers
Objekte verbinden: im Object Mode den Mo-
difier Boolean mit der Operation Union korrekt 
anwenden und das Hilfsobjekt mit [X] löschen. 
(Abb. 2)

• keine doppelten Flächen, Kanten oder 
Punkte
Im Edit Mode die Funktion Remove Doubles 
anwenden (zu finden im Tool Shelf oder mit [W] 
im Specials-Menü).

• kein Loch in der Geometrie 
Objekt muss «wasserdicht« sein. Sorgfältig 
modellieren, allfällige Löcher im Edit Mode 
manuell mit [F] verbinden oder unter Mesh > 
Clean up > Fill holes.

• keine verdrehten Flächen
Alle Flächennormalen zeigen nach Aussen. 

Abb. 2



MODUL: EXPORT

3D-Modellieren und 3D-Drucken mit Blender | S. Mauroux

BEDINGUNGEN | s. 2 / 2

Abb. 4

Im Edit Mode: Mesh > Normals > Recalcula-
te Outside. (Kontrollieren im Properties Shelf 
[N] unter Mesh Display > Normals > auf das 
Flächen-Zeichen klicken, Abb. 3)

• keine «mannigfaltigen« Kanten
Aufräumen: Entweder überschüssige Flächen 
selbst suchen und mit [X] löschen. Oder unter 
Select auf Non Manifold gehen und diese an-
schliessend mit [X] löschen. (Abb. 4, 5)

Abb. 3

Abb. 5
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Abb. 1

• Das fertig modellierte Objekt anwählen, unter 
File > Export > STL  (Standard-Schnittstelle: 
Surface Tesselation Language / Standard Tri-
angulation Language) anwählen. (Abb. 1)
• Im neuen Fenster den Namen und Speicher-
ort bestimmen. Wichtig: unten links die Scale 

auf 10 stellen. Nur so werden die Blenderein-
heiten als Zentimeter exportiert. (Abb. 2)
• Wird die Scale auf 1 gestellt, werden die Blen-
dereinheiten als Millimeter behandelt. Bei einer 
Scale von 1000 werden die Blendereinheiten 
als Meter exportiert.

• In Cura die Datei mit Laden (oben links beim 
Ordner-Symbol) importieren und die Mass-
einheiten unten links bei dem Skalier-Symbol 
überprüfen. (Abb. 3)

• Die folgenden Einstellungen je nach Objekt 
anpassen:
• Schichtdicke: (layer height) Auflösung des 
Drucks entlang der Z-Achse in Millimeter. Je 
nach 3D-Drucker von 0.4 bis 0.05 Millimeter 
einstellbar. Je kleiner die Schichtdicke, desto 
feiner die Oberfläche und länger die Druckzeit.
• Stärke der Aussenhülle: (shells) Dicke der 
Aussenwand, relevant für die Stabilität. Hier 
kann der Durchmesser der Düse (oft 0.4 mm) 
oder ein Vielfaches davon eingestellt werden. 
(0.8 mm empfiehlt sich)
• Füllung, Stärke unten / oben: (solid layers 
top/bottom) Regelt die Anzahl komplett gefüll-
ter Schichten am Boden und Deckel des Ob-
jekts. (ein Vielfaches der Schichtdicke)
• Fülldichte: (infill) Füllung des Objekts in Pro-Abb. 2

Abb. 3
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zent. 20% ergeben bereits ein stabiles Objekt. 
• Drucktemperatur: (temperature) Für ABS 
und PLA empfiehlt sich eine Drucktemperatur 
von 220°/ 230°. Diese Temperatur kann je nach 
Hersteller variieren. Bei PLA muss das Druck-
bett normalerweise nicht vorgeheizt werden, 
hingegen bei ABS schon. (auf zirka 100°)
• Stützmaterial: (support) Mit dem Aktivieren 
dieser Funktion wird an allen überhängenden 
oder steilen Bereichen (ab 45°) Stützstruktur 
dazuberechnet, welche das Abrutschen ein-
zelner Schichten verhindert und nach dem 
Druck abgelöst werden muss.
• Adhäsionstyp: (raft, brim) Zusätzliche Mög-
lichkeiten (Gitter oder Rand) der Haftung an 
der Druckplattform, welche das Ablösen des 
Objekts während des Drucks erschweren. 
Haarspray oder blaues Krepp-Klebeband be-
günstigen ebenfalls die Adhäsion.

• Beim Objekt-Symbol oben rechts lassen sich 
unter Schichten die einzelnen Querschnitte 
anschauen. (Abb. 4)
• Beim Disketten/SD-Karten-Symbol kann der 
Maschinencode (Gcode) für den Drucker auf 
der SD-Karte gespeichert werden. (Abb. 5, op-
tional mit Datei - Speichere GCode)

Abb. 4

Abb. 5


